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PURPOSE 
This SOP describes how to operate and use the CARY300 UV-VIS spectrophotometer (190-900nm) 
located in the CAF facility. More specifically, how to perform a scan with baseline correction– using the 
Scan application. 

 

SCOPE 

This SOP describes procedures to be followed by staff and students when using the Cary 300 in the CAF 
facility.  

 

RISKS.  

DO complete the CAF Blackboard safety test, official training and ONE run supervised by the CAF 
technician before using the equipment. 

See the attached Risk assessment of the instrument.  

You must have your own Risk assessment of the chemical products you are going to analyse.  

Please if you want to analyse toxic, flammable, explosive, or longer term health hazards chemicals talk with 
the CAF technician before running your samples (check their MSDS). We may need to take extra safety 
measures. 

 

 

 

 

 

 

 

 

PROCEDURE.  

 

PRECAUTIONS 

 

 Please look for technical assistance if you face any instrument warning/error.  

 Do not attempt to use if signage indicates that the instrument is out of use or is currently in use, 

 Do not spill solvents inside the cell compartment. Report any spills. 

 DO NOT leave sample waste, glassware or other materials in the lab without properly disposing of 
them. In some cases, this may require that you bring the waste back to your own lab. 
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INSTRUMENT STARTUP   

The instrument has different available accessories, including stirring capabilities. Please look for technical 
assistance if you want more information. . A new SOP and R.A will be needed when using an accessory.  

 
- The computer should be on already. You just need to ‘wake’ it up. Log on to the CAFUV-VIS user, 
password: CAFUV-VIS. If somebody has signed out you will need to sig in to the PC:  

Username: PC domain\ CAFUV-VIS. Password: CAFUV-VIS. 
Do not log on to Rdg-home with your individual logon as the instrument specific software will not function. 

- Enter in the application that you want to use. Double-click on the Cary WinUV program folder 
icon. A folder will open showing all of the acquisition and processing programs included in the 
Cary 300 Bio suite.   Calibrating the cell changer with the align app is always recommended 
before analysing your samples and you must do it if you use micro cuvettes. Therefore, you 
are advised to start opening the Align app.  

 
During the basic training session all users are shown how to use the “Scan” application, calibrate the cell 
changer and the “Cary Help” application.  The other applications are discussed briefly at the end of this 
document in Appendix A, but operational details are not included here.  You may request advanced training 
to use any of the other programs.  
  
At the moment, we have only installed a temperature controller and a multicell holder. However, we have 
other accessories that you may need, for more information look for technical assistance.  
 

 
 
 

- Turn on the instrument.  The switch is at the lower left corner, below the “Cary 300 Bio” logo.  Wait at least 
two minutes for the instrument to complete hardware initialization steps. Check for the different 
messages that appear at the bottom left corner of the application you opened before, they could indicate 
a problem.  

 

- Give the lamps at least 30 minutes of warming up before using the instrument.  

 

- Lift the lid and check to see if any samples are still in the instrument. If so contact the previous user before 
removing them to prevent interference with another experiment or potential risk to oneself.  
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- If you want to control the T of your experiment turn on the T controller which is next to the instrument. If 
you hear a strange noise or see any leak please let the engineer knows.  

 
  

- Calibration of the cell changer after the warming up period (Align app). It is important to periodically do it. 
You must do it after installing the cell changer or if you want to use micro cuvettes. For cuvettes 
information see Appendix B.  

If you use micro-cuvettes you must put the cuvettes in the positions you want to use.  For normal /macro 
cuvettes you do not need to put them in the cell changer. 

Go to the calibration cell changer tab. 
Select the cell changer type (the multicell holder that we use is the series II 6x6) 

Click start calibration and select okay (the 6 sample cells are going to be calibrated) 
Go to the graph tab. You should see a graph with 6 bars, one per each sample cell. 

Return to the calibration cell changer tab. 
The new values should be very similar for the same cell changer type. 

Once the cells have been calibrated apply new data. 
Select reset button to go to the default cell position (1) and close the align app. 

 
SCAN APPLICATION.  

These procedure steps are based on the Cary help menu < How to perform a scan with baseline 
correction (Cary 100-6000i) – Scan. If you have previously done the calibration of the cell changer, 
now double-click on the Scan icon.   The software should now open in the standard view.  
  

The view should clearly indicate that the instrument is “Scan - Online”   and the “Start” 
traffic light button should be green (not greyed out).  If the program indicates “Scan – Offline”, then exit the 

program and start 
the Scan program 
again. If you do not 
see the green 
traffic light yet, 
close the scan tab 
and go to the right 
bottom of the task 
bar and close an 
icon that it may be 
open: “system 
information”. Now 
you can open the 
scan tab again.  
 
 
 
 
 
 
 

CAUTION:  

To avoid overheating and prevent accidents do not leave the T controller on for long periods of time. 
If you are going to run analysis for the whole day, please first look for technical assistance.    
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- From the File pull-down menu, select “Open Method” if you have a method saved.  Navigate to the 
Methods folder, then double-click to select the method you would like to use.   

       ->           

- If you do not have a method saved or you want to modify your method: Use the Setup button   

 to access and modify all of the method parameters or to set a method from scratch.    
 
  

  
 
 
Setup parameters:  

a. Cary tab: Set the appropriate abscissa Mode for the scan in the X Mode group, for example 
nanometers.  

Set the wavelength range for the scan by entering the values you require in the Start/Stop fields, 
the instrument has this range: 190-900nm.   

In the Y Mode group select the ordinate Mode in which you want the collect data to be displayed, 
for example Abs.  

Enter an upper range and lower range value in the Y min and Y max entry fields to specify the 
displayed ordinate range.  

You now need to set the speed of the data collection. With the Cary instruments you do this by 
setting the Ave Time and Data Interval. In the Ave Time field enter the required value. 0.1 sec is a 
good starting point. The longer the average time the smother the scan. If you are measuring turbid 
or highly absorbing samples then higher average t is needed. 

In the Data Interval field, enter the wavelength increment you require between data points. The 
Cary will automatically update the Scan Rate field when you select it. A Data interval of 0.5 (the 
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default value used to be 1) is a good starting point. This means that every 0.5nm you record one 
absorbance point, it should be set less than 1/3 f the SBW. 

b. Select the Options tab.  

Set the SBW (standard band width), 2 is a good starting point.  

Set the Beam Mode. This is commonly set to 'Double'.  

Click on the UV/Vis button if you want both the lamps on during the run.  

Check the Auto Lamps Off check box, this will automatically turn off the lamps at the end of a 
collect.  

In the Display Options group, select the way in which you want the data displayed as it is collected. 
Choose Individual Data to display the collected data of each sample in individual graph boxes. 
Choose Overlay Data  to superimpose the collected data of each sample in the Scan run in one 
graph box.  

c. Select the baseline tab (for more info see baseline-Scan, help menu). This tab enables you to 
choose the type of baseline/s that you want to use in the Scan run. You can collect a baseline 
immediately before scanning a sample or use a stored baseline. With our multicell changer you 
should use only these options: none (if you do not require a baseline) and baseline. Even if you do 
not measure the baseline, it is always recommended to determine the blank value of each cuvette 
before the actual measurement.  

If you have matched pair cuvettes you are recommended to use them, one for your blank and one 
for your sample. If you don’t have them, ideally, you should use the same cuvette for your blank and 
for your samples.  

Baseline Correction: Select this option to apply a baseline correction (Baseline) to the sample scan 
(S) that is collected from the instrument as transmission values. This correction is thus: 
(S)/(Baseline). This option is the best one if you want to automatically subtract the Abs of your blank 
(for the whole wavelength range) from all of your samples.  

Zero/Baseline Correction: Not recommended for our cell holder, talk with the CAF technician 
before doing this. Select this option to apply a 100%T baseline correction (100%TBaseline) and a 
zero line correction (0%TBaseline) to the sample scan (S). This correction is performed with the 
raw transmission data and is thus:   ((S)-(0%TBaseline))/(100%TBaseline-0%TBaseline) 

With this option, the Cary will prompt you to perform a 100%TBaseline first, followed by a 
0%TBaseline when you perform a baseline collection. This baseline option corrects for any 
inherent variations in the electronic zero line of the instrument. You should use this baseline option 
if your samples have areas of very low transmission (high absorbance) as any variations in the 
instrument's zero line will affect your measurements if they you do not correct for these. 

Retrieve Baseline File: This button displays the Windows Open dialog where you can select a stored 
baseline file *.CSK. The trace()s in this file will be used for the selected baseline correction. 
However, Good Laboratory Practice recommends that you collect a new baseline for each 
laboratory session.  

d. Accessories tab 1:  Set up Multicell Holder accessory with multi zero if you want to analyse more 
than one sample at the same time.  If you only have one sample or one cuvette you do not need to 
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use the cell changer option. Position number 1 is the default position for both the blank and the 
sample. To be sure that the cell changer is in position number 1 select go to cell 1.  

If you want to use any other accessory please ask the CAF technician for it, we may need to install 
it. 

Select the Use Cell Changer check box to enable the Multicell Holder accessory. 
Select the cells you require from the available cells, please use only the first 6 cells for samples. 
Check the Multi Zero check box to turn on the Multi Zero facility, this in independent of the baseline 
correction option selected. This option will prompt you to put your blanks (either an empty cuvette, 
a blank solution or no cuvette at all)  in all the selected cells before the analysis of your samples. 
This option zeroes the current Abs value for each cell (this value is the Abs at the highest 
wavelength of your method) and subtracts this value to all of your future samples.  
If you want to set up a temperature for your analysis, tick Automatic Temperature Setting and 
select the Temperature Controller to enable the accessory (temperature range: -10 to 100 °C).  
Set the monitoring temperature by entering the Block temperature that you wish. We also have T 
probes for the cells, which allows monitoring of the solution T inside the cell.  
In the Temperature Display group, select Block to view the temperature of the Multicell Holder 
block in the Status Display window. You can also select probe if you are using one.  
 
Accessories 2,3 and samplers are not installed as defaults options, make sure that no options are 
selected on this tab. If you need any of them please ask the CAF technician, we may need to install 
them.   

e. Reports tab. This tab is only if you want to set up an automatic report.  

Enter your name in the Name entry field.  
Enter a comment relating to your experiment in the Comment entry field.  
Set up your report style by selecting the appropriate check boxes in the Options group.  
For example, select the AutoPrint (in pdf) check box to obtain a printout of your report 
automatically. If AutoPrint is selected, then the system will send the report information to the 
specified printer as well as the Report area. However, if AutoPrint is not selected, the report will 
only be sent to the Report area and can be viewed by selecting the Report option in the View menu.  
Select the Parameters check box to include your experimental parameters in the report.  
Select the Graph check box to include a graph in the generated report.  
Set up the Peak Table reporting. 

Press the Peak Information button and choose the type of Peak Labels, the Peak Style and 
set the Peak Threshold. Press OK.  
Select Maximum Peak  
Select All Peaks to report all peaks meeting the Peak Style criterion and exceeding the 
Threshold value.  

Set up X-Y pairs reporting if required. You can use the actual Data Interval by which the data was 
collected or you can make the Cary interpolate the points to a new Interval.  
Select the Autoconvert option (it is recommended). If you select Select for ASCII (csv) or Select for 
ASCII (csv) with Log. Then at the end of the data collection the system will automatically generate 
a report and store the data both in the Cary format as well as ASCII XY pairs format in the current 
folder. 
 

f. Select the Auto Store tab to set up whether the collected data is to be saved, and if so, when the 
Cary should ask for the file name. Select Storage On (Prompt at Start). 
 

g. Finish Set up.  Once you are satisfied with your method setup click OK to confirm any changes you 
have made and close the Setup dialog. Note that the changes you make to the method are only 
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temporary unless you save the modified method.  In case you want to save the current set up as a 
new method select:  

 Your methods MUST begin with your name, but you may extend the name with 
more descriptive elements if you wish.  Example:  Pedro_kinetics-polyphenols  .  
Methods must be saved in the Methods folder, or they will be deleted.   

 

 
 
 

ANALYSIS OF YOUR SAMPLES.  
According to the Scan application method previously described.  

For common analysis (for front bean analysis and even if you have selected the double beam option in the 
set up) you only need to use the first 6 positions of the cell changer for blanks and samples, and you need 
to leave empty the rear 6 positions. For more information about the double beam capabilities please see 
Appendix C.  

The Start button will not be enabled until the temperature of the selected Monitor is within 0.5°C of the 
Block temperature set in the Accessories tab 

The spectrometer lid has to be closed for all the measurements 

-   Zero the instrument without a cuvette in place: Click  to zero (approx. 0.00Abs)  the system. 
If you have not selected a baseline option in the set up, you can zero with a blank in the desired cuvette 
position.  

  .  

- Click .   When prompted, insert the blank sample into the desired sample position in the 
compartment front beam and press OK. 

BLANK: Fill a clean quartz/plastic cell about 2/3 full with solvent. Never completely fill a cuvette. Clean 
the sides of the cuvette with a soft tissue. The clear sides of the cuvette must be facing left and right 
(a frosted side towards you). Close the spectrometer lid.  
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The instrument runs and displays a baseline spectrum.  The instrument will subtract this baseline spectrum 
from each subsequent spectrum during your session. After the collection, the word 'baseline' will appear in 
red in the ordinate status box, indicating that you are in baseline correction mode, and the traffic light will 
be green 

However, sometimes you may notice that the text has turned to grey and is in 
italics. You still have a valid baseline file. This indicates that the Cary is currently 
idling outside the abscissa range of the baseline file.  

Hot Tip: If you want to use the baseline again in future sessions, save the 
method using File | Save Method As. Then, when you re-open the method, the 
baseline will also open and be ready to use. It is preferable to save the baseline 
with the method, rather than a baseline file, as that way you can be sure that all 

your collection parameters are exactly the same for the new Scan runs.  

- Using the eject button, carefully remove your blank.  Empty it, and then refill it with your sample solution 
in the case that you do not have matched pair cuvettes. Place the cell in the same position where you have 
run the baseline.  

- Click the Start button to start a data collection . Alternatively you can select Start in the 
Command menu. 

- Once you press Start, the Windows Save As dialog will appear. Enter the appropriate name for your Scan 
run and press Save. Save everything in the designated user’s folder: DESKTOP\USERS DATA\YOUR 
SUPERVISOR’S FOLDER\YOUR OWN FOLDER    (each user should create his own folder). 

- The Sample Name dialog will now appear. Enter the appropriate name for your sample and press OK. This 
will be used for the report. The Scan run will commence and the corrected trace will appear in the Graphics 
area. 

- Once the scan of your first sample (or sequence of samples) finishes you can follow the same procedure 
to analyse more samples. You will have two options: (All the runs will use the same method previously created in 
the setup parameters. Remember that you do not need to zero the instrument or to do the baseline again, unless 
you close the application).  

1. Click okay, name your sample(s) and the scan will start. A csv file will be generated with the data 
of all your samples, but you will only have one spectrum with all the traces/scans. 

2. Click finish if you want to save the spectrums of your new future samples in different files. Then 
select start for each of your samples.  

CAUTION:  

Do not spill solvents inside the cell compartment. Report any spills. 

Please put lids on your cuvettes to avoid any spillages.  

Do not put your chemicals directly on the bench. Instead, put your chemicals on a piece of paper towel. You 
can also use a plastic recipient.   

Please use your own beaker to clean your cuvettes and collect any WASTE you could generate. We do not 
have containers for liquid residues in CAF lab. 
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Remember that if you have not selected the autosave options in the setup parameters, now you 
can select file save as batch (BSW file) to save the life window with all the overlaid traces. Unless 
you select focus trace (the one in red) you will be saving all the traces of your graph. You can also 
select file, save data as spreadsheet to save it in Excel (overlaid traces or not) and file, save report 
as. To save the graph as a picture use the Snipping Tool.   

 

-  At the end of the run, the Cary creates the report and also print it in PDF, if AutoPrint has been selected 
in the Setup dialog. If not, you can always select the print option on the report. The report will be shown 
below your data graph.  

 The spectrum will typically appear in the upper half of the screen, followed by calculation of peak positions 
and intensities (absorbance) and generation of a report in the lower half of the screen.  The exact view 
format will depend upon the Setup parameters. Data analysis will then proceed (see Appendix D for more 
information).     

- Please send all your data by email, do not save it in a pen drive. Please note that data may be purged from 
the instrument once a year (after back up) and therefore backing up your data onto your own computer 
regularly is advisable. 

 

SHUTDOWN PROCEDURE  

  

- Once the instrument finishes (the start traffic light button will be green) remove your samples and close 
the lid.  

-  If nobody else has booked the instrument just after you, you can close the application and turn off the 
instrument and the temperature controller.  You may need to wait until the temperature controller is again 
at room temperature.  

- Please leave the PC on.  

- Fill in the UV Excel Logbook (Desktop). 

 

 

 

 

 

Technical support: Dr Pedro Rivas scs16o@reading.ac.uk 
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APPENDIX A: Application/Program Descriptions.  

The ADL Shell gives you a pre-defined template for writing ADL (Advanced Data Language) 
programs. Rather than needing to write the code for basic functions such as graphing and 
filing, the ADL Shell has a number of these commands already implemented.  

  

The Advanced Reads application allows you set up methods to read multiple samples in a 
single run. Features include finding the mean of multiple readings of the sample solution, 
finding the mean of multiple sample aliquots of the sample solution, et cetera.  

  

 Only to be used under CAF technical supervision. For your Cary instrument to operate at 
peak performance, you must ensure that the UV and (where applicable) visible lamps are 
correctly aligned in the optical path. Poor lamp alignment or the use of old, failing lamps may 
decrease the signal-to-noise ratio and adversely affect the performance of your      
instrument. The Align application enables you to perform alignment procedures.  

   

The Applications Development Language (ADL) is a BASIC-like spectroscopy language 
that is built into the Cary software.  You can write your own Cary interface to set up the 
instrument, collect and store data, calculate results and create reports.  

   

Help is available for every program included in the Cary UV-Vis software suite.  

   

The Concentration application is used to automatically determine the concentration of an 
absorbing sample, using up to a 30-point calibration for quantitative analysis. The 
application enables you to select from several curve fit types for the calibration.  

  

The Enzyme Kinetics application enables you to set up various parameters of the 
instrument and accessories, perform an Enzyme Kinetics run, and perform calculations on 
your results.  

 

The Kinetics application is used to automatically calculate reaction rates from absorbance 
versus time data.  You can also calculate emission versus time data for fluorescence 
measurements.  

  

This application enables you to scan samples across a wavelength or wavenumber range 
and manipulate the collected data. You can choose various display modes for the 
collected data depending on the type of sample you are measuring and the Cary 
accessories that you are using.  
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The Scanning Kinetics application enables you to scan samples across a wavelength or 
wavenumber range. From the resultant absorbance versus wavelength data, an 
absorbance versus time (kinetics) curve can be obtained for any wavelength in the range.  

  

The Simple Reads application is used to perform simple absorbance readings of samples. 
You can’t scan across a wavelength range. In addition, simple mathematical operations 
can be performed (via the User Collect option) on readings performed at multiple 
wavelengths.  

 

The RNA-DNA application can be used to collect data and calculate the various 
parameters used in determining the amount, type and purity of nucleic acid samples.  

  

  

This application enables you to enter your laboratory details, to select the Cary 
instrument, and store the instrument's serial number. The information stored here is 
then made available to the reporting functions of all the other applications.  

  

The Thermal application enables you to perform thermal analyses (applying different 
heating ramps) on DNA using one of the thermostatted Cary accessories. Once the data 
is collected, you can choose to calculate the melting temperature, Tm, by either the 
Derivative or Hyperchromicity method. In addition, the Thermal application can be used         

to perform: various calculations such as %GC, volume corrections to account for the 
thermal expansion of water; and normalizations of data to a given temperature.  

  

This program is only to be used by service personnel. The Validate application enables 
you to optimize the settings and validate the accuracy of the Cary 100 by executing a 
number of pre-defined tests. The tests are preset with default parameters that comply 
with international standards for Good Laboratory Practices. 

 

 

APPENDIX B: Cuvettes.  

- Spectrophotometer cuvettes (UV, VIS…):  the standard ones have two sides frozen and two polished. The 
two polished are the ones where the incident beams enters and exits. The Spectrophotometer cuvettes 
don’t work in fluorimeters due to the frozen side.   

 

- Notes on materials:  
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*UV: Quartz-Most common material, transmission range 190-2,500/170-2700 nm (depending on 
manufacturers).  

*Optical glass: less expensive than quartz. Transmission range 340-2,000 nm/ 334-2500 nm 

*Plastic: it depends on the kind of plastic, but they may not be transparent in part (if not all) of the 
UV range. Agilent polystyrene cuvettes: 340-750nm. Plastic cuvettes are available in stores.  

 

- Some standard cuvettes than can be used: 

 

*Fisherbrand Polystyrene for visible wavelengths: two sides frozen and two polished. 

Single use. Available in stores. They can be used with our Cary 300 instrument fitted with 
multicell holder or peltier 1x1 cell holder .  

 

 

*Disposable Cells. Agilent.  Part Number:6610018800. 66£. 500/pk. 

Information from help menu: cuvettes used for our Cary 300 instrument fitted with multicell 
holder or peltier 1x1 cell holder .  

Disposable standard cuvettes 10 mm pathlength, suitable for use with magnetic stirrers, but not 
elevated temperatures. 

Rectangular cell, disposable, polystyrene, 3.5 mL, 10 mm path length, 500/pk. For use over wavelength 
range from 340-800 nm with all UV models.  

 

 

* Agilent quartz standard cuvette. 6610000800.  

Information from help menu: cuvettes used for our Cary 300 instrument fitted with 
multicell holder or peltier 1x1 cell holder .  

Cell, rectangular, macro, quartz 170-2700 nm, matched pair, PTFE lid, 10 mm 
pathlength, 3500 µl. 154 £.  
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- Microcells for our Multicell Holder (6 x 6): Remember to always insert the micro cuvette in the same 
orientation.  

 

*If you have only a small volume of sample, you may wish to use microcells in the Multicell Block. Self-
masking microcells (self-masking or black walls) are recommended for the best possible results. It is not 
advisable to use unmasked microcells (clear walls microcells) in the Multicell Holder as the light may reflect 
from the inside walls of the cells, giving rise to spurious results. 

 

Note 

- If you are using the Multicell Holder to perform single-cell measurements (i.e. the Sample Transport will be 
stationary during the measurement) you can use any cell you wish as long as the ‘Z’ height (the distance between the 
bottom of the cell and the centre of the cell aperture) is 20 mm. Self-masking cells are recommended 

- We do not recommend the use of 2 mm wide semi-microcells. 

For low volume work the following cells are recommended according to the manual:   

These self-masking cells have a 4mm aperture width which make them suitable for the multicell holder of our 
instrument. They can be used with the Cary Temperature Probe accessory. They are also suitable for use will the 
standard single cell holders.  

 

 

A 1.3 mL semi microcell is supplied with a magnetic stirrer bar and features a circular stirring well at its base 
to accommodate the stirring bar and ensure that the bar spins easily (part number 6610015400). This cell 
is suitable for use with Cary 300 thermostatted (and magnetic stirring) multicell holder  

 

 

Very similar to 66 100127 00, which do not have an image.  
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* There are also another kind of micro cuvettes, without self-masking or black walls.  

Problem: they are 2mm wide, which for our cell holder are not recommended.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Some kind of cells than can be used with a different cell holder (not with the currently installed Multicell 
Holder (6 x 6) and not with the peltier 1x1 cell holder): 

 

*Long path length cuvettes for use with dilute solutions, for example:  

 

 

 

 

 

 

 

 

 

 



©University of Reading 2020  Page 16 

*Short path length cuvettes for use with concentrated samples or to overcome the absorbance of the 
solvent. For example:  

 

 

 

 

 

 

 

 

 

APPENDIX C: Double beam capabilities.   

The SOP previously described is based on the Cary help menu < How to perform a scan with baseline 
correction (Cary 100-6000i) – Scan. The double beam option is selected by default in this procedure. For 
the baseline correction it is said that:” Click the Baseline button and when prompted insert the blank sample 
into the sample compartment front beam and press OK”. Therefore, it does not say anything about using 
the 6 rear positions, which are used in a “true” double beam experiment.  

According to technical experts, it is always recommended to select the double beam option capability in 
the setup, even if you only use the first 6 cell positions for blanks and samples and leave empty the 6 rear 
positions. This is the way that has been described in the aforementioned protocol. Using this double beam 
configuration allows the instrument to correct the electronic noise of your sample results.  

How does this work? For example, if you use position number 1 for your sample and blank and leave 
reference positions empty: The “reference” and “sample” files are acquired sequentially in Position 1 of the 
multi-cell holder.  Each file is ratioed to the second beam passing through the empty Position 7.  This allows 
the “reference” ratioed file to be subtracted from the “sample” ratioed file.  If the subtraction constant is 1, 
this is exactly equivalent to dividing the Sample file by the Reference file – the definition of a transmittance 
spectrum.  If the subtraction constant is varied, then features common to the sample and reference can 
be minimized, leaving the difference spectrum.  
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Theory:  

 

 

APPENDIX D: Data analysis.    

The data generated by the instrument is saved as CSV (if you choose this option in the setup) and as DSW 
or BSW file. These last two can only be opened with the Cary WinUV software, either online or offline. 
Therefore, you do not need to turn on the instrument to carry out data analysis.  

- The current run data will be displayed automatically.  You may also retrieve previously acquired data from 
your data folder (File -> Open Data…).  Navigate to your data directory.  Be sure to specify file type .DSW.  

- Newly acquired data will show both the graphical spectrum and the report.  Previously acquired data will 
show the graphical spectrum, but will not show a report or peak list.  
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 - To generate a report (based upon your Setup -> Reports method parameters) left-click in the graph area 
so that the black outline and handles are now displayed.  From the action buttons on the 
left, select  “Recalculate” . The report will now be displayed.  

 - Use the tools on the ribbon bar to edit and/or annotate the spectrum.  

   

 - The graph must be “selected” for some of the tools to be operable.  Note that there is no 
“zoom in” tool.  The standard left mouse click-and-drag action is used to zoom in.  

- You may use the Scale Graph button  to expand or contract the scan to fit the graphic 
area and to set and select preset ranges for plotting.  

  

  

- If you acquire dilution data in order to get the peaks of interest within a quantifiable concentration range, 
you will probably want to overlay the graphs.  When you have a satisfactory scan, click the Trace 
Preferences button  and uncheck all scans (traces) except the one to be printed. Click OK. Only 
one scan is visible.  
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- Use the Peak Labels button  to adjust the peak labels as desired.  

- If more than one scan was acquired, click Clear Report  to remove all trace reports, and then 

click Recalculate  to rewrite a report for just the scan(s) visible.  

 - Look over the report. Use the menu command Edit: Edit Report,  and edit 
(write in the report) as required. Click anywhere off of the report to exit the edit mode.  

- When the report is satisfactory, click Print   to save it as a PDF. You can also select file, print, 
PDF.  
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